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1.0 Contact Info

If you have questions regarding your task as outlined in this booklet, contact the volunteer
coordinators:

Mr Jayden Engert & Dr Yoko Ishida

Centre for Tropical Environmental & Sustainability Science
James Cook University

Building E2 Room 022

Phone: 4232 1427

Email: tess.volunteers@jcu.edu.au

2.0 General Overview

2.1 The Goal of this Exercise

The presence of roadways is one of the clearest and most significant indicators of human’s
occupation and perturbation of the natural environment. Road infrastructure is poised to expand
greatly globally, particularly in the tropics, as populations, incomes and economic ambitions
continue to expand. Knowing the extent and nature of current roadways will help decision
makers prioritise where new roads should and should not be situated in order to balance
economic development with ecological conservation.

The research project to which you will contribute as a citizen scientist seeks to define this
balance. As a first step, the project will, with your assistance, develop a spatial database of
existing roads across insular Southeast Asia, including those roads not officially mapped or
recognised by national governments. In this way, researchers at James Cook University will be
able to assess the current extent of roads amongst remaining ecologically-intact areas and
indicate where proposed road infrastructure should and should not be situated.



2.2 The Basics of your Task

Using free Google Earth software to view satellite imagery of insular Southeast Asia (Indonesia,
Malaysia, Papua New Guinea, Brunei), you are charged with two tasks:

(i) Visually identifying and manually mapping ‘new roads’ not already mapped by
existing-road maps, and

(ii) Classifying these ‘new roads’ according to whether they are paved or unpaved as
well as the date of observation.

The following pages will detail the step-by-step instructions necessary to achieve these goals.
Rest assured, these are simple and straightforward. Due diligence and care are however of the
utmost importance to ensuring an accurate and useful final map of roadways in the region.

Note: These instructions are intended for users of Windows computers. If you have an
Apple/Mac computer, the commands will be subtly different from that of a windows
computer. If you move easily between Macs and PC’s, you likely won’t have any issues.

2.3 Terminology Used In this Booklet

Existing Roads: Refers to those roads already mapped in a freely available dataset, either by a
national government (official road data) or citizen scientists (Open Street Map) or other groups.
Our ultimate goal is to add to these existing roads by looking for and mapping unmapped ‘new
roads’ in Google Earth. Note. For the purposes of this study, Google roads are not considered
existing roads, therefore you should turn off the Google roads layer in Google Earth, if it is visible.

New Roads: Refers to those roads you visually identify and manually map using Google Earth and
which are not part of an existing road dataset. The roads are not ‘new’ in the sense that they
have been recently constructed, though some may have been. Rather, they are ‘new’ in the
sense that they are not part of the existing road dataset and so are instead newly discovered by
us through visual analysis of Google Earth satellite imagery.

Attribute Data: Refers to the basic attributes or characteristics of the new roads we map. When
we visually identify, interpret and map a new road we will also label the new road with its
corresponding attributes, thus creating attribute data. The specific attributes of interest for us
are as follows:

* road paved status (i.e., paved or unpaved), and

* observation date of the road (i.e., the acquisition date of the satellite imagery in Google
Earth in which the new road is observed).



Google Earth File: Refers to computer files with a file extensions of “.kmz” or, sometimes, “,kml”.
These files are map files that Google Earth uses, and which you can edit within Google Earth.

2.4 Google Earth and Your Digital Materials

Google Earth is a free software that allows users to view satellite imagery of any region of the
Earth. We will use it to identify and map new roads alongside existing roads, which you will also
view in Google Earth. You can freely download Google Earth and install it on your computer at
this link:

https://www.google.com/earth/download/ge/agree.html

An internet connection is required to perform the tasks outlined in this booklet.

As detailed in later sections, you should already have the following Google Earth map files, which
are required to get started mapping new roads. Contact Mr Engert if you do not have these.
* Afew maps of existing roads, specific to your assigned region in insular Southeast Asia.

These files have names based on the existing data source and the location, like 25k
123.kml’, ‘50k 456.kml’, osm_789.kml’, etc.

* One map of a ‘fishnet’ graticule with individually numbered grid cells of ~10x10 km,
probably called Grid_SEA.kml, specific to your assigned region in insular Southeast Asia.


https://www.google.com/earth/download/ge/agree.html
https://www.google.com/earth/download/ge/agree.html
https://www.google.com/earth/download/ge/agree.html

3.0 Detailed Overview

3.1 Maximising Your Computer Resources

The existing-road maps we will view in Google Earth can be taxing for your computer. To help
your computer handle them, begin by instructing your computer to operate in ‘high performance’
mode, as seen in Figure 1.

‘® Power Options — O X

» ‘% > Control Panel > Hardware and Sound > Power Options v O | Search Control Panel »p
Control Panel Home x
Choose or customize a power plan

Choose what the power A power plan is a collection of hardware and system settings (like display brightness, sleep, etc.) that manages
buttons do how your computer uses power. Tell me more about power plans
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Create a power plan . y :
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Figure 1: Power Options on your Computer

Find this option on your computer either by either (a) right clicking the battery symbol on the

lower-right of your screen (Figure 2) or by (b) going into Control Panel > Hardware and Sound >
Power Options.

[# Dell Extended Battery Life Options
kd Dell Power Manager Lite

Adjust screen brightness

Windows Mobility Center

A oz B=OING e

Figure 2: Power Options on Your Computer

Also, close any other programs your computer is running (e.g., Skype) so that it is not
unnecessarily diverting resources to them.



3.2 Getting to Know Your Existing-Road Map

You will begin with various maps of existing roads for the region of insular Southeast Asia in which
you’ll be working. Your specific region will be clear to you at the outset of your work, as it will be
delineated in Google Earth by your map of ‘grid cells’ (see Section 3.3 for details on your map of
grid cell).

The existing-road maps with which you’ll begin your mapping of new roads will capture most, but
not all, of the roads visible in Google Earth. We have obtained the best available existing road
maps for each region, however there will likely still be many new roads to map. Roads that are
visible but unmapped are of interest to us —these are the ‘new roads’ we wish to map. These
new roads will occur amongst the existing roads as well as in the peripheries of areas containing
existing roads.

The existing-road maps you have will are Google Earth map files. In this booklet, the Google
Earth map file of existing roads | will use as an example is called ‘JALANLN_50K’ (Jalan means
‘road’ in Indonesian). Your existing-road maps will not have this name, however. Rather, your
Google Earth map files of existing roads will have various names depending on the source of the
data, and will appear something like those below.

* 25k 123.kmz
* 50k 456.kmz
* osm_789.kmz
* log_5253.kmz

In Section 3.2.3 | explain the reason behind this particular file name convention for your Google
Earth map files of existing roads. You can still read through Section 3.2.1 and 3.2.2 without knowing
this reason.

3.2.1 Basic Contents of a Google Earth File (of Existing Roads)

Let’s look at an existing-road map in Google Earth to get orientated. Open Google Earth on your
computer, then in Google Earth add to your display a single Google Earth map file of existing
roads, e.g., ‘'50k 123.kmz’, or whatever your file happens to be called. Do so by going to File >
Open and then selecting any single Google Earth map file of existing roads. Google Earth should
automatically zoom to the extent of your existing-road map, as in Figure 3 below. Alternatively,
you can open your map files by double clicking on the file icon in whatever location you have
saved it.
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Figure 3: Initial View of Existing-road map in Google Earth

Hint: Later, if necessary, you can open more than one existing-road map at once. This will be

necessary in two situations:

(i)

(i)

For a single location, you must simultaneously display two existing-road maps of
different scales (recall Section 3.2.3, and consult Section 5.1.2).

The local area (i.e., ‘grid cell’ as per Section 3.3) in which you are mapping new roads
spans the edges of two adjacent existing-road maps.

It is recommended that you only add as many existing-road maps to your display as is necessary,
because these files are taxing on your computer’s resources and may slow down your navigation
within Google Earth.

Your computer should now look like Figure 3 above. However, your existing-road map will have a
different file name, be for a different location, and it will likely be a different colour to Figure 3.
Note the following points of interest in Figure 3, which also apply to your display.

The Google Earth map of existing roads, here called JALANLN_50K, is indicated by a globe
symbol on the left-hand panel of Google Earth. In Figure 3 above it is highlighted in blue.

In the left-hand panel in Google Earth, the file JALANLN_50K is visible under the heading
‘Temporary Places’. All files listed under the heading Temporary Places are Google Earth
files that you have saved in specific directories on your computer, e.g., C:\My
Documents\My Existing Road Maps\JALANLN_50K.kmz. This is exactly how we want it.
Never save any of your Google Earth files in your ‘My Places’ directory in Google Earth,
which is also visible in the left-hand panel in Figure 3. Doing so would transfer your
Google Earth map file to some hard-to-find directory on your computer.



In the left-hand panel, to the very left of your map of existing roads (‘JALANLN_50K’ here), you
will see plus symbol, as below:

+ M= JALANLN_50K

Click on the plus symbol to expand the map file of existing roads (JALANLN_50K). The plus symbol
has now turned into a minus symbol (“-“), and you should now see a little folder or ‘subdirectory’
of the same name as your existing map of existing roads (JALANLN_50K here), as highlighted in
Figure 4 below.

Get Directions History |
Y riares
s U S My Places
5 Temporary Places
= B = JALANLN_50K
+ B O )AL ANLN_50K

Figure 4: Expanded View of Existing-road map JALANLN_50K.

The sub-directory JALANLN_50K also has a plus symbol to its left, as in Figure 4. Click on this plus
symbol to expand the sub-directory and see its contents. The plus symbol has again now turned
into a minus symbol as your view becomes like in Figure 5.
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Figure 5: Fully Expanded View of the Google Earth File of an Existing-road map, JALANLN_50K.



Each of the little elements in Figure 5, here titled “[no_name}”, are individual roads in the Google
Earth map file of existing roads, JALANLN_50K. In the language of Google Earth these elements
are ‘ways’, i.e., individual linear features in the Google Earth file. On your computer, these
elements might occasionally be labelled “NULL” or similar, but their particular name does not
matter for us.

There are lots of ‘ways’ — often too many to scroll through. If you double-click on an individual
‘way’ in the left-hand panel of Google Earth you will automatically zoom to the corresponding
individual road. Even after zooming to that road it may be hard to identify it amongst the many
other roads surrounding it. It is some help to know that a given individual road in question will be
situated in the centre of your screen and will be defined as a single length spanning the two
nearest intersections of roads.

Technical Tip: If your computer takes a long time to zoom to the road you doubleclicked
on and/or takes a long time to refresh the display after zooming, you might find it helpful
to increase the speed with which Google Earth zooms and pans. Do this by going to menu
Tools > Options. In the dialogue box that appears, click the ‘Navigation’ tab and increase
the ‘Fly-To-Speed’ setting as in the picture below.

= Google Earth Options ? X
3D View | Cache | Touring Navigation General |
Fly-To
Fly-To Speed: [4.4360 Slow al Fast

Mouse Wheel

Fast

=3

Speed: Slow
[ Invert mouse wheel zoom direction

Non-mouse Controller Navigation

[ Enable Controller “ Do not automatically tilt while zooming

©  Automatically tilt while zooming

©  Automatically tilt and enter ground level view

¥~ Enable Visualization [*" Gradually slow the Earth when rotating or zooming

[ Reverse Controls

Restore Defaults OK Cancel Apply

At this point, in the left-hand panel of Google Earth, click on the minus symbol next to the
subdirectory (folder) JALANLN_50K to collapse it so that your view is like Figure 4 again. Similarly
click the minus symbol next to the Google Earth file JALANLN_50K to collapse it so that your view
is again like in Figure 3.

10



3.2.2 Changing the View of a Road Map

Before going too far, let’s change the colour of your existing-road map to ensure that its roads are
readily visible in Google Earth. The following steps are also applicable to the map of new roads
that you will eventually create.

It is essential that your maps of existing roads display roads in different colours to the new roads
you will eventually map. This will help you keep track of where you have already mapped new
roads, so that you don’t repeat your efforts. Note that changes to the colour of your road maps
in Google Earth might be temporary, so you may have to repeat these steps each time you add a
Google Earth map file of existing or new roads to your display in Google Earth.

With your view in Google Earth looking like Figure 3, right click on your map file of existing roads
(JALANLN_50K here) in the left-hand panel. In the pop-up menu that appears, select ‘Properties’.
A dialogue box with various tabs should appear in Google Earth. In the dialogue box, click the tab
“Style, Colour”, as in Figure 6 below. In this box, you can adjust the colour, width, and opacity of
the existing roads in your map file, JALANLN_50K. | recommend the settings show in in Figure 6.

Google Earth - Edit Folder n

Name: [JALANLN_50K

[*" Allow this folder to be expanded
[ Show contents as options (radio button selection)

Description Style, Color | View | Altitude |

Lines
Color: [[] Width: [1.0 = Opacity: [100% =

Balloon

Text:

OK Cancel l

Figure 6: Style and Colour Tab in the Properties Dialogue Box for JALANLN_50K Existing-road map.

Before clicking ‘ok’ in the dialogue box, click on its ‘Altitude’ tab. Confirm that the option for
altitude in this tab is set to ‘clamped to ground’, as shown in Figure 7 below. If this option is not
as in Figure 7, change it so that it is. Now click ‘ok’ to close the Properties dialogue box.
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Google Earth - Edit Folder n

Name: [JALANLN_S0K

[*" Allow this folder to be expanded

[~ Show contents as options (radio button selection)
Description \ Style, Color | View Altitude \

Altitude: |V-‘m \Clamped to ground j
Ground Ji Space

[~ Extend path to ground

OK Cancel |

Figure 7: Altitude Tab in the Properties Dialogue Box for JALANLN_50K Existing-road map.

3.2.3 Naming Convention for Map Files of Existing Roads

As mentioned above, your Google Earth map files of existingt roads will have names that appear
much like those below.

* 25k 123.kmz
* 50k 456.kmz
* osm_789.kmz
* log_5253.kmz

Your map files of existing roads will begin with different prefixes depending on the source of the
data. Official road maps from the Indonesian and PNG governments will begin with one of the
three prefixes ‘25k’, ‘50k’ or ‘250k’. For those of you mapping new roads in Kalimantan
(Indonesian Borneo), virtually all your official road-map files will have the pre-fix ‘50k’. Existing
road maps in Malaysian Borneo (Sabah or Sarawak) will have prefixes “osm” for maps obtained
from Open Street Map and “log” for maps obtained from the Borneo Logging Road project.

To avoid confusion, it is important that you understand the meaning of the file names of your
Google Earth map files of existing roads. In short, the file name for any given Google Earth map
file of official roads contains two bits of information about the official-road map in question:

1. The geographic scale of a given Google Earth map file of official roads for Indonesia or
PNG is indicated by the prefixes of the file names (e.g., ‘25k’, ‘50k’ or 250k’ in the
examples above). In non-technical terms, the geographic scale of a map indicates the
level of detail and spatial accuracy one can expect in that map. For our maps of official
roads, the prefix ‘25k’ indicates a fine scale of 1:25,000 (i.e., high level of detail), the prefix
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‘50k’ indicates an intermediate scale of 1:50,000 (i.e., moderate level of details), and the
prefix 250k’ indicates a coarse scale of 1:250,000 (i.e., low level of detail).

2. The location within insular Southeast Asia of a given Google Earth map of existing roads is
indicated by the suffix of the file name (e.g., ‘123’, ‘456’, ‘789’ in the examples above).
The actual numerical references do not concern us. Suffice to note here that, in simple
terms, each number denotes a different location from the next. The suffixes in your actual
Google Earth map files of existing roads will have anywhere from one to four numerical
digits.

As there may be multiple road map files for your area of interest, it is important to open all
Google Earth files for your package at the same time. It is important to recognise this so that you
do not repeat your efforts by consulting the same location twice. Section 5.1.2 makes use of the
preceding information when instructing you on the specifics of mapping new roads in Google
Earth.

3.3 Getting to Know Your Grid-Cell Map

You have been assigned to search for new roads in a specific region of insular Southeast Asia.
Your specific region is delineated by your single Google Earth map file of ‘grid cells’, which is
called either Grid_SEA.kml (for those working in Sumatra) or Grid_SEA_####.kml (for those
working elsewhere), where ‘####’ is a uniqgue numerical code that identifies the location of your
region, e.g., 2589, 1234, etc. This location-identification code ‘#### can be disregarded — it is not
important to you. For some regions this location-identification code will match the existing road
location code, however for other regions it will not, so it is not worth paying too much attention
to.

This map of grid cells displays a few hundred contiguous grid cells, which are ‘squares’ of
approximately 10 km by 10 km each. The grid cells will help you keep track of where you have
already mapped new roads within your region so you do not repeat your efforts. You are tasked
with mapping new roads only within the grid cells of your map file, Grid_SEA.kml.

3.3.1 Changing the View of Your Grid-Cell Map

When you first open your grid-cell map in Google Earth (File > Open), it will look similar to Figure
8. However, your grid cells will also be of a different colour, and they will probably be opaque,
not transparent (outlined). As already done for the existing-road maps (Section 3.2.2), you can
change the colouring and shading of your grid cells to make them transparent and bright.

O Right-click the grid-cell file in the left-hand panel in Google Earth, select ‘Properties’ in the
pop-up menu; select the ‘Style, Colour’ tab in the resulting dialogue box, and set the ‘line’
(i.e., grid cell outline colour) to a bright colour different to that of your existingroads; set
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the drop-down menu for ‘area’ (i.e., fill) to ‘outlined’, as below, so that the cells are no
longer opaque.

Google Earth - Edit Folder

Name: |Grid_SEA_Layer1

v | allow this folder to be expanded
Show contents as options (radio button selection)

Description | Style, Color | View = Altitude

Lines

Color: . Width: | % | Opacity: 100}’/.: v,

Area

Color: |_ Ouﬁined ¥ | Opacty: | 100% v /|

Ra

Balloon

Figure 8 displays only the grid-cell map in the left-hand panel. In reality, while you are mapping
new roads you will have both the grid-cell map and one or more existing-road map(s) loaded in
Google Earth at once.

As done previously for our existing-road map, expand the grid-cell map ‘Grid_SEA’ in the lefthand
panel in Google Earth to see its sub-directory, which is also called Grid_SEA. Then expand that
sub-directory to see all the individual elements inside it, as per Figure 9.

= Google Earth - X
File Edit View Tools Add Help
¥ Search

v Places

# 0= MyPlaces

= M Temporary Places
= M Grid_SEA

Malaysia
& MIED Grid_SEA Y

v Singapore

AT Y m—T i i Google Earth

» Layers Earth Gallery »> Imagery Date: 12/14/2015 ~ 0°42'21.87" N 1 "E elev 68m eyealt1901.05km

Figure 8: Grid-cell map for a Given Region within insular Southeast Asia
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Figure 9: Expanded View of the Contents of the Grid-cell map

As with the individual roads of the existing-road map (Figure 4), each element of the grid-cell map

(i.e., the listed ‘no name’ boxes in Figure 9) is an individual grid cell of approximately 10x10 km.
Your region will likely have 10 — 30 grid cells.

With your view of the grid-cell map’s contents expanded as per Figure 9, double click on any one
of its elements (blue ‘no name’ cells) in the left-hand panel. Google Earth should immediately
zoom to that cell. | double clicked the first cell and zoomed to it, as shown in Figure 10.

= Google Earth Pro
File Edit View Tools Add Help
v Search

Get Directions History
¥ Places
» [ [ MyPlaces
v ¥ & Temporary Places
v Y1 Grid_SEA Layerl
v [/ &3 Grid SEA Layerl

FIDPLUS1 13496
FIDPLS1 13496
Province Kalimantan Tengah
RegioniD 2450

(a[m] PR ‘ Google Earth

> Lavers

1°54'54.00"E elev. Om eyealt 15.17km

Figure 10: Initial View of a Single Grid Cell
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Note that when you zoom to your cell, as in Figure 10, a pop-up bubble appears in the center of

the grid cell. This shows you a unique identification number for the grid cell in question, labelled
‘FIDPLUSY1’ and ‘FIDPLSY’ (they are the same number). You can disregard this and close the pop-
up label.

3.3.2 Using your Grid-Cell Map to Efficiently Map New Roads

You are responsible for mapping new roads throughout all grid cells defined by your Google Earth
map file of grid cells. When mapping new roads you’ll want to inspect your grid cells one by one
and individually ‘tick off’ each cell you inspect. This is very important, both for you to avoid
revisiting cells later and for the larger JCU research project to keep track of which cells have been
mapped. The method to tick off cells is outlined below.

Hypothetically, let us suppose that you are assigned only three grid cells: A, B and C. (Of course,
in reality and as per Figure 10, these will all be identified as ‘no name’ in the lefthand panel of
Google Earth). To begin your mapping, let’s start with grid cell A. In the lefthand panel in Google
Earth, double click on the element for cell A (or whichever is your first grid cell in your file) to
zoom to that grid cell, as in Figure 10.

As in Figure 10, your ‘cell A’ should still be transparent and brightly outlined, after having followed
the steps above. After inspecting grid cell A and mapping all its roads, we will change both the
colour and the label of cell A to indicate that we have finished mapping all its roads.

To do so, in the left-hand panel of Google Earth, right click the element for grid cell A (or
whichever is your first cell) and select ‘Properties’ in the resultant pop-up menu, then...

* ..Inthe ‘Description’ tab of this ‘Properties’ dialogue box, write “done”, as shown below,
and then...

Google Earth - Edit Placemark

Name:ldond

Description Style, Color View Altitude

* ..Inthe ‘Style, Colour’ tab of this same ‘Properties’ dialogue box, adjust the ‘Area’ colour
parameter from ‘Outlined’ to ‘Filled + Outlined’, selecting whichever opaque ‘fill colour’
you wish, as in Figure 12. Now click ‘ok’, and your ‘cell A’ will look a lot like mine in Figure
12.
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Now your ‘grid cell A’ should be completely opaque and have a new ‘done’ label in the lefthand
panel (Figure 12), while your remaining cells are still transparent and labelled as ‘no name’. This
method of re-labelling and re-colouring must be strictly adhered because later stages of the JCU
project depend on it.

At this point we can double click on the element for the next cell in the left-hand panel (being ‘cell
B’ in this example), automatically zoom to its location, map new roads there, recolour and re-
label that cell as described above, then move on to do the same in the next ‘cell C’, and so on.
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Figure 12: Grid Cell A is Now Denoted as ‘Done’

3.4 Saving Your Altered Grid-Cell Map

This section concerns saving changes to your grid-cell map, Grid_SEA_####.kmz. Saving changes
to the Google Earth map file of new roads that you will create entails a slightly different
protocol, described in Section 5.2.

Within a given session of Google Earth, change you make to a Google Earth map file are
temporary. These changes include: (a) adjustments to the colours/opacity of grid cells, (b)
changes to the names of individual grid cells, and (c) the mapping of new roads (Section 5.1.3).

To save such changes to your Google Earth map files you must save your map files before closing
Google Earth. Strangely, in Google Earth the way to save changes to a Google Earth map file is to
save a new version of the map file! In the case of our altered grid-cell map Grid_SEA_####, we do
so as follows:
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* Inthe left-hand panel of Google Earth, right click the Grid_SEA_#### Google Earth map file

(not its sub-directory of the same name). In the pop-up menu that appears, select ‘Save

Places As’, as per Figure 13 below. DO NOT become confused and select the option ‘Save

to My Places’.

* Specify the new file name and a directory location for the altered version of the gridcell

map Grid_SEA_#### you are saving.

o Helpful Hint: | recommend saving the altered file with the same name as the original
plus the date on which you save the file, e.g.,
Grid_SEA_#### Nov28.kmz, presuming you altered the file on November 28. This

way, after many sessions in Google Earth in which you create many versions of a
given map file, you will still easily know which version of your map file is the most
recent. Keep older version alongside newer versions in a single directory (e.g.,
‘C:\My Documents\My Grid Maps\’). This way, should you discover that your
current version of a map file is rubbish, you are still able to re-commence work

from an earlier version of the file.

In your subsequent mapping sessions in Google Earth, you can continue your work by opening the

most recent version of your Google Earth map file of grid cells (e.g., Grid_SEA__ ####Nov28.kmz)

and new roads (discussed in later sections).

It’s also a very good idea to continually save your work as above during a Google Earth session,

especially if your computer is prone to freezing or crashing. You will lose all your unsaved work if

(or rather, when) Google Earth crashes!!!
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Figure 13: Saving an Altered Google Earth File to a New File
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When you close Google Earth, you’ll see the dialogue box below. If all your changes to your
Google Earth files are already saved to a new version of the file (e.g.,
Grid_SEA_##t## Nov28.kmz), click ‘Discard’. If not, click ‘Cancel’ and save new versions of the
files. Never click ‘Save’ in the dialogue box below. (If you do, your files will be saved, but they’ll

be transferred to your ‘My Places’ directory deep in your C drive controlled by Google Earth,
making them harder to find and update later).

=~ Google Earth X

‘ You have unsaved items in your “Temporary
J Places" folder. Would you like to save them to
your "My Places" folder?

Save Discard Cancel
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4.0 Mapping New Roads

4.1 How to Map New Roads and Assign Them Attribute Data

In Google Earth, your display should now have both a transparent grid-cell map (Section 3.3.1)
and at least one existing-road map. This section discusses how to use these files to search for
new roads, how to map the new roads in Google Earth, and how to assign attribute data to these
new roads.

4.1.1 How to Search for New Roads Within Your Grid Cells

Using your map(s) of existing roads as a reference of where roads already exist, visually search for
new roads in Google Earth on a cell-by-cell basis. Zoom to an individual grid cell and visually scan
its area for new roads in a systematic manner. For example, scan from left to right and from top
to bottom. This way you are most likely to visually identify all new roads in your grid cell with the
least investment of time and without overlooking areas within your grid cell. Once you have fully
scanned the grid cell and mapped any new roads it contains, do not forget to make that grid cell
opague to remind yourself that you have finished working within it (Section 3.3.2).

4.1.2 Protocols for Mapping New Roads (Important)

There are a few basic protocols applicable to the search for and mapping of new roads, listed
below. These are essential to ensuring a minimum standard of scientific reliability, and so must
be adhered to at all times.

* You must not attempt to visually identify (and certainly not map!) roads while viewing the
Earth at altitudes greater than 5 km. In non-technical terms, the altitude of observation is
your ‘zoom level’ in Google Earth. While visually scanning your grid cell, you are
encouraged to ‘zoom in’ using Google Earth as close as necessary in order to identify and
map the new roads (Section 5.1.3). In Figure 14, you can see where Google Earth reports
your ‘visual altitude’ above the Earth (4.88 km in the figure) as well as the buttons by
which you can increase or decrease your altitude / zoom. In practice you will generally
view the Earth at altitudes ranging from 1-4 km.

* Do not search for and map new roads in towns, urban areas, cities, and other areas
characterised by concentrations of houses, buildings, etc. (‘settlements’ hereafter).
Rather, concentrate your efforts in all other areas. Clearly, the exact boundary between
‘settlements’ and ‘all other areas’ is a bit of a grey area, so you are required to use your
best judgement as to what constitutes a settlement.
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o The images below provide some indication of what the term ‘settlement’ refers to
for our purposes. Note how ‘Not Settled’ areas may still be characterised by
concentrations of infrastructure, typically that associated with oil-palm plantations
or other agriculture. Such areas are not primarily residential, although sparsely
distributed residences may occur within them. Areas characterised by
concentrations of residences and associated shops etc. are considered
‘Settlements’.

Not
Settled
)16 DigitalGlobe Google Earth
Not
Settled

Google Earth

Imagery Date? 7/6/2015  2°31'13.19"'S 104°08'55.62" E elev 11 m eyealt 2.01 km

p 2014
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Settled

Google Earth

17m eyealt 1.44km

o Ifin doubt about what constitutes a settlement, consider the following questions:

= Are the new roads you are observing for conveying people around their
settlement?  Or rather are they for conveying people between
settlements, across rural areas, within plantations, etc.?

= Are the new roads you are observing lined by houses or buildings? Or
rather are they situated in rural, agricultural, and/or forested contexts
characterised by only occasional buildings?

If in doubt about whether a given feature visible in Google Earth is actually a road or some
other linear feature, such as a gully, dry river bed, etc., do not map the feature as a new
road. Similarly, if you suspect that a linear feature might be a road but cannot be certain
because it is overgrown with vegetation, do not map it as a new road.
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Figure 14: View of Altitude and Zoom Button in Google Earth

If you are mapping new roads in Sumatra (skip to next section if otherwise): Recalling
the meaning of the ‘prefixes’ (i.e., scales) and ‘suffixes’ (i.e., locations) of the names of
your Google Earth map files of official roads (Section 3.2.3), where two map files of official
road exist at different scales but for the same location you should display both map files
simultaneously in Google Earth while searching for new roads. For example, if | have the
official-road maps 250k 612.kmz’ and ‘50k 612.kmz’, these are clearly both for the same
location, denoted by the suffice ‘612’, so | should display both these officialroad maps
simultaneously in Google Earth while scanning for new roads in the location covered by
these two maps. The simultaneous observation of both maps of official roads is important
because the official-road maps of different scales are generally incomplete in different
ways, so that only together do they present a complete picture of the extent official roads.

o  When simultaneously displaying two maps of official road with different scales for
the same locations, it is a good idea to colour the coarser-scale map with a thicker,
darker lines than the finer-scale map (see Section 3.2.2 for map colouring). When
viewing both maps of official roads at once for a given location, you’ll note that
they do not align perfectly with each other. This is due to their difference in scale.
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Generally, the coarser-scale map will be less accurate than the finer-scale map.
That is ok.

o Maps of official road of different scales for the same locations occur only in a few
areas of insular Southeast Asia:

= Sumatra — maps of official roads at the scale of 250k’ coincide with maps of
the scale ‘50k’ across the entire island of Sumatra. (Google ‘Sumatra’ if you
do not know where it is). So, for those of you mapping new roads
anywhere in Sumatra, ensure that you are displaying both your officialroad
maps at 250k and 50k scales for any given location.

4.1.3 How to Map New Roads in Google Earth

Visually identifying a new road in Google Earth is relatively straightforward, and so is not
discussed at length here. Basically, you know a road when you see it. This section instead
discusses the following points:

* Road mis-interpretation
* Properly interpreting road attributes

* Mapping new roads as a Google Earth map file, and assigning new roads their
corresponding attribute data

4.1.3.1 Potential Mis-Interpretation

The main source of road mis-interpretation arises from the occurrence of drainage canals in
peatlands. Peatlands are swampy areas roughly distributed throughout insular Southeast Asia as
per the brown areas in Figure 15. Figure 16 shows some drainage canals in peatlands, which
apparently define the extent of a plantation. The canals are distinguished from roads by the fact
that canals are filled with water and so are far darker than dirt roads, some of which also visible in
Figure 16 running alongside canals.

A similar but far rarer potential sources of mis-interpretation may arise from corridors of
electrical transmission wires running between pylons (large electrical towers). These corridors
often cut long linear swaths through vegetation, and so may appear as roads. These corridors
may, in fact, occasionally be accompanied by parallel service roads running along their lengths (as
for the electrical company), which in turn may be used by the public. In such cases, you could

then map the service road as a ‘new road’, provided that it is not already captured by your
existing-road maps, of course.
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Figure 15: Peatlands in Insular Southeast Asia (Indonesia, Malaysia but excluding Papua New

Guinea).
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4.1.3.2 Interpreting Road Attributes

As stated in Section 2.2, you are tasked with interpreting and recording two attributes of
the new roads you map:

* Road paved status (i.e., paved or unpaved), and

* Observation date of the road (i.e., the date of the satellite imagery in Google Earth
in which the new road was observed).

Observation date is the easiest attribute to identify. This attribute is simply the acquisition
date of the satellite imagery shown in Google Earth for the area in which you visually
identify a new road. In Google Earth, this date is visible at the bottom of the screen. In
Figure 14, for example, the “imagery date” is reported as “2/25/2016", reflecting a “M DD
YYYY” format for recording the date (M = month, D = day, Y = year). We will use a slightly
DIFFERENT date format when recording the reported date as attribute data for our new
roads, namely MM_DD_YYYY, as detailed in Section 5.1.3.3.

Interpreting road paved status is also straightforward. Most new roads will be unpaved.
Compared to paved roads, unpaved roads are characterised by the relatively bright colours
of bare tropical soil and/or gravel, often with shades of orange, brown, white and grey.
Figure 16 shows an unpaved road.

Figure 17 shows both paved roads (north-sound orientation) and unpaved roads (east-west
orientation). As this figure illustrates, often the best means of identifying a given road’s
paved status is to compare it to nearby features, including other roads, bare patches of
earth, etc.. This is particularly the case for roads that appear to be paved, as confirming
that a road is paved is often tricky.

2 Google Earth a
Eile Edit View Tools Add Help
vSearch

Google Earth

m eyealt 342m

Figure 17: Paved (North-South) and Unpaved (East-West) Roads in an Qil-Palm Plantation.
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Other tricks for properly interpreting a road’s paved status are listed below:
* Asshown in Figure 18, paved roads will often have unpaved edges or gullies. These
stand out as bright edges against the darker bitumen of the paved road. This
‘contextual interpretation’ helps identify a road as paved.

* Asshown in Figure 19, unpaved roads may occasionally display tyre tracks. Care
must be taken in differentiating parallel tyre tracks from the parallel unpaved edges
of paved roads in Figure 18. Knowing your local context (e.g., plantation,
intersettlement road) and visual altitude above the Earth (193 m in Figure 19) will
aid you in this respect.

= Google Earth
File Edit View Tools Add Help
vSearch
[ search
ex: Pizza near Clayville, NY
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Imagery Date; 6/18/2014  1°35'32,62" N 100°57'58.79" E'elev 20 m eyealt 243m

Figure 18: Paved Road (Northwest-Southeast Orientation) with Bare Dirt Edges.
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Figure 19: Unpaved Road with Tyre Tracks in an Oil Palm Plantation

4.1.3.3 Digitising New Roads and Assigning Them Attribute Data

Mapping or ‘digitising’ new roads simply entails using your mouse to trace a road visible in
Google Earth on your computer screen. In doing so, you map a new road or ‘way’ that is
part of a larger Google Earth map file. Recall that we are interested in mapping only those
‘new roads’ not already captured by the existing-road maps. The following text explains
how to map new roads and assign them their corresponding attribute data.

In preparing to map new roads during your first session of Google Earth, it is essential that

we first create a new sub-directory in whichever Google Earth map file of existing roads
that you happen to be viewing. Any Google Earth map file of existing roads will suffice.
The new sub-directory you create will exclusively contain the new roads we map through
our first session of Google Earth. Before the end of our first session we will convert this
new subdirectory of new roads into a stand-alone Google Earth map file of new roads,
which we can then build upon during later mapping sessions.

e In Google Earth, in the left-hand panel, highlight (i.e., click on) the folder labelled
‘Temporary Places’.

¥ ¥ & Temporary Places
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e In Google Earth, at the top of the screen, click the ‘Add” menu and select ‘New
Folder’, as below. Alternatively you may right click on the ‘Temporary Places’

folder.
S Google Earth Pro
File Edit View Tools

¥ Search Folder Ctrl+Shift+N
i Placemark Ctrl+Shift+P
‘ Path Ctrl+Shift+T
Get Direcl:! Polygon Ctrl+Shift+G
¥ Places ‘ Model Ctrl+Shift+M
v VS My Places ‘ Tour
» ¥ (D Sightseeing Tout Photo
i Image Overlay Ctrl+Shift+0
hA 1> Temporary Places | Network Link

P VIS 50k 486 :
. .§ Grid-SEA-Layen i

* Label your new folder (i.e., sub-directory) thusly: “YOUR LAST

NAME_NewRoads_THE PACKAGE NAME”. In my example, my new folder’s name is

“Sloan_NewRoads_3462". Move your folder into the ‘Temporary Places’ directory
by clicking and dragging it. Your left-hand panel should now look like mine below.

& Google Earth Pro
Eile Edit View JTools Add Help

¥ Search

Get Directions History
¥ Places

v /& My Places
b ¢/ D Sightseeing Tour

v [¥/&3 Temporary Places
¥ [ Sloan_NewRoads_3462
b VIS 50k 486
b ¥ Grid_SEA_Layerl

Before digitising your first new road, ensure that your new sub-directory (i.e.,
Sloan_NewRoads_3462) is still highlighted in the left-hand panel, as shown immediately
above. Highlighting this sub-directory before digitising a new road tells Google Earth that
we want the new road ‘way’ to be saved into this particular sub-directory and not
elsewhere. This is important.
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Now that we are set up to map new roads, we can do so according to these steps:
In the row of buttons at the top of the screen in Google Earth, click the one labelled ‘Add

Path’, which is the third to the right of the yellow push-pin button. ‘Path’ s just another
word for ‘way’ or ‘road’, i.e. a linear feature.

Ho Slee @& @& LI Halkl=

* Adialogue box appears in which you specify the name of your new road. The name
of your new road will contain all the attribute data for the road, so it is important
that you understand this step well. The name of your new road will be a composite
of the following bits of information, in order, with each bit separated by a “_”
character:

o Your last name
o The term ‘NewRoad’, without spaces and with both ‘N’ and the ‘R’ capitalised
o ‘1"iftheroad is paved, or a ‘2’ if the road is unpaved

o The observation date, in the format MM_DD_YYYY.

So, in the case of an unpaved new road | identify in Google Earth in a satellite image with
an observation date reported as “2/25/2016”, | would label this new road as
“Sloan_NewRoad_2_02_ 25 2016”.

Similarly, in the case of a paved new road | identify in a satellite image having the same
observation date, | would label it as “Sloan_NewRoad_1 02_25 2016".

Finally, for a paved road with a reported observation date of 12/9/2015, | would label this
new road as “Sloan_NewRoad_1 12 09 2015”.

Tip: In the first example immediately above, note how the month of observation
reported by Google Earth is ‘2’ (as in February) but it is then ‘padded’ with a leading
0 in our attribute data so that it becomes ‘02’. This is essential to ensuring that
each and every month is denoted by two numerical digits, from ‘01’ (January)
through to ‘12’ (December). The same principle applies to days of the month. Thus,
the first day of the month is denoted ‘01’, not ‘1’, while the 10t day is simply
denoted as ‘10'.
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Before clicking ‘ok’ in the dialogue box for your new road, you must still digitise the road
itself. You’ll now notice that when you hover your mouse over Google Earth it looks like a
‘cross hair’ symbol. As you click your mouse along the road visible in Google Earth you can
record little points or ‘nodes’ connected to each other by lines, all of which are now visible
on your screen. Continue to do this along the entire length of the new road you are
mapping. While you are in this digitising mode you can still adjust your ‘zoom’ (altitude) as
usual. You can also pan your view up/down and left/right in Google Earth using the four
arrow keys on your keyboard. To finish digitising your new road, double click at the end of
the road to define its ‘terminal node’ or click ‘Ok’. Your new road will now be digitised, and
you can click ‘ok’ in the dialogue box to finally record the new road within your sub-
directory.

* Once your new road is thus labelled and digitised, it should appear as in Figure 20.
(Your road will of course have a different shape and colour).

* If you make a mistake and wish to delete a given new road ‘way’, simply right click it
in the left-hand panel and select ‘delete’ in the pop-up menu. (Use the same
method to remove whole map files from your display in Google Earth. Choosing to

‘delete’ a map file from your display will not delete the actual file from your
computer).
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Figure 20: A Digitised New Road (in Teal Blue)
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4.2 How to Save Your New-Road Map in Google Earth

Upon mapping a few new roads during your first session of Google Earth you are now ready
to save your sub-directory of new roads (“Sloan_NewRoads_3462" in Figure 20) as a stand-
alone Google Earth map file. Once saved as a new Google Earth file, can you continue to
add new roads to this map file in later sessions of Google Earth.

Saving Google Earth map files was discussed in Section 3.4. However, the process for saving
a map of new roads is slightly different, so pay careful attention here.

Like in Section 3.4, to save your new roads right click on the sub-directory of new roads
(‘Sloan_NewRoads_3462’ in Figure 20) in the left-hand panel and select ‘Save Places As...” in
the pop-up menu. You can now specify where on your computer you wish to save your new
roads as a stand-alone Google Earth map file. The default name of your new Google Earth
map file of new roads will be the same as your sub-directory of new roads
(Sloan_NewRoads_3462.kmz). To help keep track of your mapping efforts, you should

make the name of your new road file a composite of the following bits of information, in

o n

order, with each bit separated by a character:

o Your last name
o The term ‘NewRoads’, without spaces and with both the ‘N’ and the ‘R’ capitalised

o The XXXX location-identification code from the Grid cell being mapped
o The mapping date, in format MM_DD_YY, so you know which file is the most recent

o As you should be saving your file regularly to avoid losing progress if Google Earth
crashes, it is useful to add an extra number at the end of the file name to note which
is the most recent file.

Therefore, your new road file, with all new roads mapped in XXXX grid will have a name
something like Sloan_NewRoads_3462 08 22 19 1.kmz.

This name might seem a bit long, but including this information will ensure you can keep
track of your new road files and not lose time by re-doing work that you have already done.

4.3 Mapping New Roads within Grid Cells

Many new roads you observe will of course cross the boundaries of a given grid cell. In this
situation, there are two courses of action you may take, depending on where the road lays:

* Where a road crosses from one grid cell into an adjacent cell in Grid_SEA_####.kml,
simply map the road seamlessly as it crosses from one cell to the other.
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*  Where a road crosses from one grid cell into adjacent space that is not within any of
your grid cells in Grid_SEA_####.kml, simply map the road in question as far as the
edge of your grid cell. In other words, cease mapping the road once you reach the
edge of your grid cell.

4.4 Frequently Asked Questions

1. What if my existing-road maps are ‘inaccurate’?

You will notice that many roads mapped by a Google Earth file of existing roads are slightly
offset (typically by ~10-50 meters) from the roads visible in Google Earth. The degree of
offset will be greatest for maps of 250k’ scale and least for maps of ‘25k’ scale. Such
offsets should NOT be interpreted as meaning that a given road visible in Google Earth has
not been captured by an existing-road dataset. Consider such roads to have been fully
captured by an existing road dataset, regardless of any such offsets.

Occasionally you may also notice that your Google Earth map files of existing roads display a
road occurring where Google Earth indicates no such road exists. For example, the existing
road map may display a road through a forest that Google Earth indicates is still intact.
Overlook any such discrepancies.

2. When digitising a new road that actually intersects an existing road according to
the satellite imagery of Google Earth, should | extend the digitisation of the new
road so that it intersects the existing road if that existing-road map is offset from
the satellite imagery of Google Earth?

No. Just digitise (trace) the new road over where you see it occurring as per the underlying
satellite imagery of Google Earth. Do not ‘extend’ the new road beyond where the satellite

imagery shows it to occur.

See also Question 1 above. In general, the degree of offset of an existing-road map relative
to the roads visible in the Google Earth satellite imagery will be about 10-50 meters.

3. What if | am unsure whether | am observing a road in Google Earth?

If in doubt about whether a given feature visible in Google Earth is actually a road or some
other linear feature, such as a gully, dry river bed, etc., do not map the feature as a new
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road. Similarly, if you cannot be certain that a linear feature is a road because it is
overgrown with vegetation, do not map it as a new road.

4. What if a new road | observe is both paved and unpaved along its length?

Map (digitise) the paved length separately from the unpaved length, since each length will
require different attribute data.

5. What | observe a new road that disappears and reappears over its length? When
digitising this new road, should I interpolate its invisible lengths on the basis of
those lengths that | can clearly see?

No, just digitise road lengths that you can clearly see and interpret as roads. Do not
interpolate or ‘guess at’ lengths of new roads that you cannot clearly see as such. Where a
given new road disappears and reappears, as may occur be the case for disused seasonal
roads under a forest canopy, define the road as multiple ‘ways’ in Google Earth, which each
‘way’ being a visible segment of the road.

6. What if there is no imagery date in Google Earth for the location | am mapping?

There are three potential solutions to this problem.

1. Wait a few seconds. The image date ‘loads’ from the internet after your image loads
in Google Earth. If your internet is slow, the image date might not appear for 5-10
seconds after you pan to a new area.

2. Zoom in very close (e.g., <1 or 2 km altitude) and/or zoom in and then moderately
zoom out, say to 4-5 km altitude. This seems to make the image date appear where
previously done was displayed.

3. Failing option one and two, click the ‘clock’ button in the toolbar in Google Earth,
shown below...

@’4

...this button shows the archive of all Google Earth images available for a given location over
time, from earliest to latest. In the example shown below, you can see images are available
between 1984 and 2016. You can click through the images. Each is dated by month and
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year of the image in the archive in the upper left, e.g., 12/2014 for Dec. 2014 in the
example below. The white text at the bottom of the screen confirms this date to be
12/05/2014 in the example below. If this white text is for some reason not visible to you,
just assume that the day is ‘01’ and record the date (in this case) 12/01/2014 when naming
any new roads in the area using the information at hand, following the standard
MM_DD_YYYY date format. Clearly, you’ll want to date your new road according to the

latest image that shows that road! Click the clock button once more to return to the
normal mode in Google Earth.
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